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1.  About these Instructions for Use
These Instructions for Use guide the user in utilizing the AltoStar® SARS-CoV-2 
RT-PCR Kit 1.5 on the AltoStar® Automation System AM16 (Hamilton; in the 
following summarized as AltoStar® AM16) with the AltoStar® Connect software 
(Version 1.6.16 or higher, Hamilton) for automated PCR setup and on the CFX96™ 
Deep Well Dx System* (Bio-Rad, in the following summarized as CFX96™ DW Dx) 
with the CFX Manager™ Dx software (Version 3.1, Bio-Rad) for real-time PCR. The 
main operation steps of the complete "AltoStar® Workflow" (for details see chapter 
6.4 AltoStar® Workflow) are described for comprehensibility but without any claim 
for completeness. 

For more detailed information about these products please refer to the respective 
manuals or instructions for use:

• AltoStar® Automation System AM16 Operator's Manual IVD (Hamilton) 

• AltoStar® Connect Software Manual IVD (Hamilton) 

• Instructions for Use AltoStar® Purification Kit 1.5 

• Instructions for Use AltoStar® Internal Control 1.5 

• CFX96™ Dx and CFX96™ Deep Well Dx Systems Operation Manual (Bio-Rad)

Throughout this manual, the terms CAUTION and NOTE have the following 
meanings:

CAUTION

Highlights operating instructions or procedures which, if not followed 
correctly, may result in personal injury or impact product performance. 
Contact altona Diagnostics Technical Support for assistance.

NOTE

Information is given to the user that is useful but not essential to the task 
at hand.

Read the Instructions for Use carefully before using the product.

* “CFX96™ Deep Well Dx System” is the new brand name for the IVD version of the CFX96™ 
Deep Well Real-Time PCR Detection System (Bio-Rad).
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2.  Intended Use
The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is an in vitro diagnostic test, based on 
real-time PCR technology, for the qualitative detection of severe acute respiratory 
syndrome coronavirus 2 (SARS-CoV-2) specific RNA in respiratory swab specimens. 
It is configured for use with the CFX96™ Deep Well Dx System (Bio-Rad) in 
combination with the AltoStar® Automation System AM16, the AltoStar® Purification 
Kit 1.5 and the AltoStar® Internal Control 1.5. 

The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is intended to be used as an aid for 
diagnosis of SARS-CoV-2 infection.

The results generated with the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 have to be 
interpreted in conjunction with other clinical and laboratory findings. 

The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is intended for use by professional 
users trained in molecular biological techniques.

3.  Kit Content
The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 contains the following components:

Table   1: Kit Components

Lid Color
AltoStar® 
SARS-CoV-2 1.5 
Component

Number of Tubes Nominal Volume 
[μl/Tube]

Blue Master A 100 60
Purple Master B 100 180

Red Positive Control 
(E gene + S gene) 10 250

White NTC* 10 250

* No Template Control
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CAUTION

Before first use check the product and its components for completeness 
with respect to number, type and filling. Do not use a defective or 
incomplete product, performance could be compromised.

The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 contains enough reagents to perform 
96 reactions in a maximum number of 100 runs.

The product is shipped on dry ice. Upon receipt and before first use please check 
the product and its components for:

• Integrity 

• Completeness with respect to number, type and filling 

• Correct labelling 

• Expiration date

• Frozen state 

• Clarity and absence of particles

If one or more product components are not frozen upon receipt, if tubes have been 
compromised during shipment or are missing, contact altona Diagnostics Technical 
Support for assistance (see chapter 14 Technical Assistance).

4.  Storage and Handling
All reagents included in the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 are ready-to-use 
solutions.

4.1  Storage
All components of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 must be stored 
between -25 °C and -15 °C upon arrival.
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CAUTION

Improper storage conditions may lead to a compromised product 
performance.

CAUTION

Do not use product components beyond the expiration date printed on 
the component label.

4.2  Handling

CAUTION

Do not exceed thaw-freeze-sequence and handling durations as 
specified in these Instructions for Use.

CAUTION

Improper handling of product components and samples may lead to 
contamination causing incorrect IVD examination results.

 - Do not interchange vial or bottle caps, as cross-contamination may 
occur. 

 - To minimize the risk of carryover contamination store positive and/or 
potentially positive material separated from the kit components.

 - Use separated working areas for sample preparation/reaction setup 
and amplification/detection activities. 

 - Always wear disposable gloves. 

 - Do not open the PCR plates post amplification to avoid contamination 
with amplicons.

NOTE

Only components of the same kit lot are compatible.
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4.2.1  Master A and Master B
After thawing, Master A and Master B are stable for 5 hours at up to +30 °C.

NOTE

If Master A and Master B were thawed but not used, they can be refrozen 
and thawed again once for later runs. If opened, discard the lids and use 
new lids to avoid contamination of the reagents.

4.2.2  Positive Control and NTC
1. After thawing, the Positive Control and the NTC are stable for 5 hours at up to 

+30 °C. 

2. Discard the lids of the Positive Control and NTC tubes at each use and use 
new lids to avoid contamination of the reagents. 

3. After use close the Positive Control and NTC tubes with new lids and freeze 
them immediately. 

4. Do not exceed the following thaw-freeze-sequence for the Positive Control and 
NTC tube: Thaw 1 → Freeze 1 → Thaw 2 → Freeze 2 → Thaw 3 → Freeze 3 
→ Thaw 4

5.  Background Information
Severe acute respiratory syndrome coronavirus 2 (SARS-CoV-2) is a positive 
sense, single stranded RNA virus belonging to the family Coronaviridae, genus 
betacoronavirus, subgenus lineage B.

SARS-CoV-2 emerged in the Wuhan region of China in December 2019 and has 
spread worldwide within 2 months. The virus was initially termed as 2019-nCoV 
(novel Coronavirus) and renamed as SARS-CoV-2 by the “International Committee 
on Taxonomy of Viruses”, on 11.02.2020. At the same time the WHO named the 
disease, caused by SARS-CoV-2, COVID-19. Considering the rapid escalation and 
propagation of COVID-19 worldwide, the WHO characterized the outbreak as a 
pandemic on 12.03.2020.
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SARS-CoV-2 is highly contagious and transmitted via aerosols and droplets and 
causes acute respiratory infections with flu-like symptoms. Mainly, but not exclusively, 
in elderly people and persons with pre-existing illness, infection with SARS-CoV-2 
can lead to severe and life-threatening disease. Cases of asymptomatic infection, 
mild illness, severe illness, and deaths have been reported.

6.  Product Description
The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is an in vitro diagnostic test for the 
qualitative detection of lineage B of betacoronaviruses (E gene) and SARS-CoV-2 
(S gene) specific RNA in respiratory swabs within the AltoStar® Workflow (for details 
see chapter 6.4 AltoStar® Workflow).

It is based on real-time RT-PCR technology, utilizing reverse-transcriptase (RT) 
reaction to convert RNA into complementary DNA (cDNA), polymerase chain 
reaction (PCR) for the amplification of E gene and S gene specific target sequences 
and fluorescently labeled target specific probes for the detection of the amplified 
DNA.

In addition to the E gene and S gene RNA specific amplification and detection 
system the assay includes oligonucleotides for the amplification and detection of the 
IC (AltoStar® Internal Control 1.5). The IC is automatically added at the beginning 
of the nucleic acid purification procedure on the AltoStar® AM16. For details refer to 
the Instructions for Use of the AltoStar® Internal Control 1.5.

The probe specific for E gene RNA is labeled with the fluorophore FAM™ and 
the probe specific for S gene RNA is labeled with the fluorophore Cy5. The probe 
specific for the IC is labeled with a fluorophore detectable in the VIC™ channel.

Using probes linked to distinguishable dyes enables the parallel detection of 
E gene and S gene specific RNA and the Internal Control in corresponding detector 
channels of the CFX96™ DW Dx.
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6.1  Master A and Master B
Master A and Master B contain all components (PCR buffer, reverse transcriptase, 
DNA polymerase, magnesium salt, primers and probes) to allow reverse transcription, 
as well as the PCR mediated amplification, target detection of E gene and S gene 
specific RNA and of the IC (AltoStar® Internal Control 1.5) in one reaction setup.

6.2  Positive Control
The Positive Control (E gene + S gene) contains standardized concentrations 
of lineage B of betacoronaviruses (lineage B-βCoV) and SARS-CoV-2 specific 
RNA. It is used to verify the functionality of the lineage B-βCoV and SARS-CoV-2 
specific amplification and detection systems included in the AltoStar® SARS-CoV-2 
RT-PCR Kit 1.5.

6.3  No Template Control
The No Template Control (NTC) contains no lineage B-βCoV and SARS-CoV-2 
specific RNA but does contain the Internal Control template. The NTC is used as 
negative control for the lineage B-βCoV and SARS-CoV-2 RNA specific real-time 
RT-PCR and indicates possible contamination of Master A and Master B.

6.4  AltoStar® Workflow
The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is intended for use within the AltoStar® 
Workflow. The AltoStar® Workflow includes the following steps:

1. Programming an AltoStar® Run. 

2. Purification Run on the AltoStar® AM16 using the AltoStar® Purification Kit 1.5 
and the AltoStar® Internal Control 1.5. 

3. PCR Setup Run on the AltoStar® AM16 using the AltoStar® SARS-CoV-2 RT-
PCR Kit 1.5. 

4. Real-time RT-PCR Run on a CFX96™ DW Dx.
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All sample types and sample volumes specified for use with the AltoStar® Purification 
Kit 1.5 can be processed simultaneously on the AltoStar® AM16. Each sample can 
be analyzed with as many assays in parallel as the available eluate allows.

NOTE

Assays with differing PCR temperature profiles are automatically sorted 
to separate PCR plates.

 7.  Samples

7.1  Sample Types
The following sample type is validated for use with the AltoStar® SARS-CoV-2 
RT-PCR Kit 1.5:

• Respiratory swabs collected in universal transport medium

CAUTION

Do not use other sample types! The use of other sample types may 
compromise the product performance.

7.2  Sample Collection and Handling
Commercially available dacron fiber- or polyester-tipped swabs with plastic shafts 
have to be used for sample collection. Dry swabs must be resuspended in universal 
transport medium (e.g. UTM® from Copan). Calcium alginate swabs, swabs with 
wooden shafts and/or cotton tips as well as swabs collected in agar gel must not 
be used. Transport should occur following the local and national instructions for the 
transport of biological material.

Before use respiratory swabs resuspended in UTM® should not be stored for more 
than 48 hours at room temperature (20 °C - 25 °C), 5 days at 2 °C - 8 °C or 2 months 
at -25 °C to -15 °C.
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CAUTION

Always treat samples as infectious and (bio-)hazardous in accordance 
with safe laboratory procedures. For sample material spills promptly 
use an appropriate disinfectant. Handle contaminated materials as 
biohazardous.

NOTE

Frozen storage of samples does not compromise kit performance. 
When working with frozen samples, make sure samples are completely 
thawed and properly mixed before use.

NOTE

The samples must be free of solids and high-viscosity constituents. 
Solids and high-viscosity constituents will interfere with the sample 
transfer on the AltoStar® AM16 and the samples will not be processed.

NOTE

Do not use calcium alginate swabs, since this might lead to incorrect or 
invalid results due to PCR inhibition.

NOTE

Do not use swabs with wooden shafts and/or cotton tips or swabs with 
agar gel as transport medium, since remains of wood, cotton and/or 
agar may interfere with the sample transfer on the AltoStar® AM16 and 
the samples will not be processed.

7.3  Sample Volume
The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is validated for nucleic acid purifications 
from a sample volume of 500 μl. Additional sample volume has to be provided to 
account for the dead volume of the sample tube used (see chapter 7.4 Sample 
Tubes).
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7.4  Sample Tubes
Sample tubes suitable for use on the AltoStar® AM16 can be purchased from altona 
Diagnostics (7 ml tube with cap, 82 x 13 mm, VK000010). Other sample tubes can 
be tested for applicability by the user. For details refer to the Instructions for Use of 
the AltoStar® Purification Kit 1.5.

7.5  Sample Barcodes
For automated sample identification by the AltoStar® AM16 all sample tubes must 
be labeled with a suitable barcode. For details refer to the Instructions for Use of the 
AltoStar® Purification Kit 1.5.

8.  Material and Devices Required, but not Provided
The material and devices shown in Table 2 must be ordered from altona Diagnostics 
GmbH.

Table   2: Required material and devices

Material Name Description Order No.
Shipping 

Unit

AltoStar® AM16 AltoStar® Automation System AM16 806160 1

AltoStar® Connect software
AltoStar® Connect software (Version 
1.6.16 or higher)

911275 1

CFX96™ DW Dx
CFX96™ Deep Well Dx System* 
(Bio-Rad) with CFX Manager™ Dx 
software (Version 3.1)

DT16 1

AltoStar® Purification Kit 1.5 AltoStar® Purification Kit 1.5 PK15-16 1

AltoStar® Internal Control 
1.5

AltoStar® Internal Control 1.5 IC15-16 1

PCR Plate
Hard-Shell® PCR Plate 96-Well, 
Low-Profile, Semi-Skirted, Clear 
shell, White well - barcoded

VK000005 25
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Material Name Description Order No.
Shipping 

Unit

AltoStar® PCR Plate Sealing 
Foil

AltoStar® PCR Plate Sealing Foil 
with cut corner A1 and 10 mm sides 
(SP-0235)

VK000006 100

1000 μl CO-RE Tips
CO-RE Tips, 8 x 480 High Volume 
Tips (1000 μl) with Filters

VK000007 3840

300 μl CO-RE Tips
CO-RE Tips, 12 x 480 Standard 
Volume Tips (300 μl) with Filters

VK000008 5760

Pooling Tube
Tube 5 ml, 92 x 15.3 mm (round), 
PP, with barcode

VK000002 1000

Waste Bag
Sterilbag, Bag Type 60 - Autoclave 
134 °C

VK000009 500

Screw Cap - red (cap for 
Positive Control)

Screw cap for micro tubes, red VK000012 5000

Screw Cap - blue (cap for 
Master A)

Screw cap for micro tubes, blue VK000013 5000

Screw Cap - purple (cap for 
Master B)

Screw cap for micro tubes, purple VK000015 5000

Screw Cap - white (cap for 
NTC)

Screw cap for micro tubes, white VK000016 5000

* “CFX96™ Deep Well Dx System” is the new brand name for the IVD version of the CFX96™ 
Deep Well Real-Time PCR Detection System (Bio-Rad).

NOTE

Do not use other materials or devices than specified in these Instructions 
for Use.
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Table   3: Additional laboratory material and devices 

Material Description Order No.
Shipping 

Unit

Plate Sealer e.g. AltoStar® Plate Sealer VK000023 1

General material and devices:

• Vortex mixer 

• Powder-free gloves (disposable)

• Centrifuge for centrifugation of PCR kit reagents 

• Centrifuge for centrifugation of PCR plates 

 9.  Warnings, Precautions and Limitations
• Before first use check the product and its components for completeness with 

respect to number, type and filling. Do not use a defective or incomplete 
product, performance could be compromised.

• Do not use other sample types! The use of other sample types may compromise 
the product performance.

• The presence of PCR inhibitors may cause false negative or invalid results.

• In case the sample contains other pathogens than SARS-CoV-2 competition 
with the target amplification or cross-reactivities may occur.

• Improper storage conditions may lead to a compromised product performance.

• A lack of centrifugation of the product components after thawing could lead 
to contamination of the components with reagent residues in the lids and as 
consequence to a compromised product performance.

• Do not exceed thaw-freeze-sequence and handling durations as specified in 
these Instructions for Use.

• Do not reuse tube caps to avoid contamination of the reagents.

• Do not use product components beyond the expiration date printed on the 
component label.

• Improper handling of product components and samples may lead to 
contamination causing incorrect IVD examination results.
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 ◦ Do not interchange vial or bottle caps, as cross-contamination may occur.

 ◦ To minimize the risk of carryover contamination store positive and/or 
potentially positive material separated from the kit components.

 ◦ Use separated working areas for sample preparation/reaction setup and 
amplification/detection activities.

 ◦ Always wear disposable gloves.

 ◦ Do not open the PCR plates post amplification to avoid contamination with 
amplicons.

• Storage of eluates under wrong conditions may lead to degradation of the 
SARS-CoV-2 target sequence. 

• Do not exceed the PCR Mix storage time. This could lead to a compromised 
product performance.

• Always treat samples as infectious and (bio-)hazardous in accordance with 
safe laboratory procedures. For sample material spills promptly use an 
appropriate disinfectant. Handle contaminated materials as biohazardous. 

• Dispose of hazardous and biological waste only in compliance with local and 
national regulations to avoid environmental contamination. 

• As with any diagnostic test, results should be interpreted in consideration of all 
clinical and laboratory findings.

• Potential mutations within the target regions of the SARS-CoV-2 genome 
covered by primers and/or probes used in the test may result in failure to 
detect the presence of the pathogen.
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10.  Procedure

10.1  Overview of the AltoStar® Workflow
The steps of the AltoStar® Workflow are summarized in Table 4.

Table   4: Overview of the AltoStar® Workflow

Step Action

1. Start the AltoStar® AM16 • Switch on the AltoStar® AM16.
• Switch on the computer and the monitor.
• Start the AltoStar® Connect software.

2. Perform Maintenance In the menu bar click Application → Instrument 
Maintenance. 

• If Weekly Maintenance is due, click Start Weekly 
Maintenance.

• If Daily Maintenance is due, click Start Daily 
Maintenance.

Follow the on screen instructions for the maintenance 
process.

3. Program an AltoStar® 
Run

In the menu bar click Program Run → Program Run 
(AltoStar® Purification). Alternatively, go back to the Start 
Screen and click the Program Run button.

• Enter samples or import from the LIMS,
• Select assays for the samples unless already imported 

from the LIMS,
• Click the Create Run button in the tool bar to create 

the AltoStar® Run.



22

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

Step Action

4. Start a Purification Run In the menu bar click Purification → Start Purification. 
Alternatively, go back to the Start Screen and click the Start 
Purification button.

• Select the Purification Run to be started to display the 
samples included in the selected Purification Run.

• Prepare the purification reagents:

 ◦ Ensure that the purification reagents to be used 
have the same Loading Number (except AltoStar® 
Internal Control 1.5) and are not expired.

 ◦ If precipitates are visible in the Lysis Buffer, heat it 
(≤ 50 °C) until completely dissolved.

 ◦ Thaw the IC (AltoStar® Internal Control 1.5) and 
vortex for 5 seconds.

 ◦ Vortex the Magnetic Beads for 5 seconds without 
wetting the lid.

• Prepare the samples for the Purification Run to 
be started as described in chapter 10.6.1 Sample 
Preparation.

• Click the Start Run button in the tool bar.
• Follow the loading dialogs and load the instrument 

accordingly.
• Confirm the Loading complete message with Ok or 

wait 10 seconds.

The system will now perform the Purification Run 
automatically.

5. Finish the Purification 
Run

• Make sure the Loading Tray is empty and confirm the 
Run finished dialog with Ok.

• Follow the instructions in the Maintenance dialog and 
confirm with Ok.

• Seal and store the components of the AltoStar® 
Purification Kit 1.5 that can be reused.

• If the associated PCR Setup Run is not started right 
away, seal the Eluate Plate with the AltoStar® Eluate 
Plate Sealing Foil and store at 2 °C to 8 °C for up to 
24 hours.

• View the Purification Run results to confirm successful 
processing of each sample.
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Step Action

6. Start a PCR Setup Run In the menu bar, click PCR Setup → Start PCR Setup. 
Alternatively, go back to the Start Screen and click the Start 
PCR Setup button.

• Select the PCR Setup Run to be started in order to 
display the Eluate Plate and reagents included in the 
selected PCR Setup Run.

• Prepare the PCR reagents:

 ◦ Ensure that Masters and Controls to be used are 
from the same kit lot and are not expired.

 ◦ Thaw the required amount of Master and Control 
tubes, vortex briefly and spin down in a centrifuge.

• If the Eluate Plate is sealed, briefly centrifuge the plate 
and unseal carefully.

• Click the Start Run button in the tool bar.
• Follow the Loading dialog and load the instrument 

accordingly.
• Confirm the Loading complete message with Ok or 

wait 10 seconds.
• The system will now perform the PCR Setup Run 

automatically.

7. Finish the PCR Setup 
Run

Make sure the Loading Tray is empty and confirm the Run 
finished dialog with Ok.

• Follow the instructions in the Maintenance dialog and 
confirm with Ok.

• Close and store the components of the AltoStar® 
SARS-CoV-2 RT-PCR Kit 1.5 that can be reused.

• View the PCR Setup Run results to confirm successful 
processing of each sample.

8. Seal the PCR Plate • Seal the PCR Plate with the AltoStar® PCR Plate 
Sealing Foil.
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Step Action

9. Start the PCR Run • Switch on the CFX96™ DW Dx, the attached computer 
and the monitor.

• Start the CFX Manager™ Dx software.
• Open the CFX96™ DW Dx.
• Centrifuge the PCR Plate and insert it into the 

CFX96™ DW Dx.
• Select File → Open → LIMS File… from the menu 

bar.
• Scan the barcode of the PCR Plate with the handheld 

barcode scanner.
• Close the CFX96™ DW Dx.
• Click the Start Run button to start the PCR Run. Name 

and save the PCR run file.
• The CFX96™ DW Dx will now perform the PCR Run 

automatically.

10. Separate assays for 
individual analysis

• Separate all assays in the PCR Run into distinct Well 
Groups.

11. Analyse the data and 
interpret the PCR Run 
results

For each Well Group individually:

• Perform baseline correction in all wells for all detection 
channels used.

• Exclude wells with irregular PCR signals.
• Set the thresholds of all detection channels according 

to the controls.
• Exclude wells containing invalid data.
• Generate the LIMS Result File for export of results to 

the LIMS.
• Generate the result report for manual result 

interpretation.
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10.2  Starting the AltoStar® AM16
1. Turn on the AltoStar® AM16 with the front left green switch and start the 

computer by pressing the power button. 

2. Wait until Windows has booted.

3. Start the AltoStar® Connect software using the a* icon on the Windows desktop, 
the Windows task bar or in the Windows start menu.

The Start Screen of the AltoStar® Connect software is displayed (see Figure 1) 
showing three buttons representing the AltoStar® Workflow steps to be performed 
on the AltoStar® AM16:

• Program Run: Sample data are entered and assays are assigned to the 
samples. The programmed samples are then assigned to an AltoStar® Run 
(see chapter 10.5 Creating an AltoStar® Run), which includes one Purification 
Run and one or more PCR Setup and PCR runs. Several AltoStar® Runs can 
be preprogrammed in advance. 

• Start Purification: A programmed Purification Run is selected and started as 
described in chapter 10.6 Starting a Purification Run. 

• Start PCR Setup: A programmed PCR Setup Run is selected and started as 
described in chapter 10.11 Starting a PCR Setup Run.
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Figure   1: Start Screen of the AltoStar® Connect software
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10.3  Performing Maintenance
1. Access the Maintenance Screen by clicking Application → Instrument 

Maintenance in the menu bar (see Figure 1). 

A valid status of the Daily Maintenance and Weekly Maintenance is depicted by a 
green check mark in the column Status (see Figure 2). If a red crossed circle is 
displayed, the respective maintenance procedure has to be performed.

If the Daily or Weekly Maintenance has to be performed:

1. Click the corresponding button in the tool bar.

2. Follow the on screen instructions to complete the maintenance procedure. 
Refer to the AltoStar® Automation System AM16 Operator's Manual IVD and 
the AltoStar® Connect Software Manual IVD for detailed information.

The maintenance routines verify the correct functionality of the instrument and will 
prompt all necessary user actions including cleaning of the instrument.

NOTE

Verification refers to the semi-annual maintenance procedure that is 
performed by Hamilton trained field service engineers. The Verification 
row must show a green check mark in the column Status as well. 
Otherwise the instrument will not process any samples or reagents.
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Figure   2: Maintenance Screen with valid maintenance status
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10.4  Programming an AltoStar® Run
Input of sample data and assay assignments can be done manually (see chapter 
10.4.1 Manual Programming) or by import from a connected Laboratory Information 
Management System (LIMS). If no manual programming is necessary, continue 
with chapter 10.4.2 Importing from LIMS.

10.4.1  Manual Programming
1. Click Program Run → Program Run (AltoStar® Purification) in the menu bar. 

Alternatively, go back to the Start Screen of the AltoStar® Connect software and 
select the Program Run button.

The Programming Screen is displayed (see Figure 3) showing the sample table at 
the bottom of the screen with columns for:

• Sample properties: Sample Name (optional), Sample Barcode, Sample 
Type and Predilution

• Sample settings: Process Sample, Sample Priority

• Sample information: required Sample Volume for the Purification Run (dead 
volume not factored in), Eluate left (determined by assay assignment) 

• Assay assignment to the samples: Programming

NOTE

The sample settings Process Sample and Sample Priority are selected 
manually while the sample information Sample Volume and Eluate left 
are set automatically when assigning PCR assays to the samples.
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Figure   3: Programming Screen

2. Click the Add Samples button to manually add samples to the sample table. 
The Add Samples dialog will appear (see Figure 4).
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Figure   4: Add Samples dialog

3. Select the sample type Swab in the Sample Type field.

NOTE

If the wrong sample type is selected in the Sample Type field the sample 
may not be processed.

4. Optional: Enter a sample name in the Sample Name field. 

5. Enter a barcode via the handheld barcode scanner in the Sample Barcode 
field. A unique barcode for each sample tube is required. 

6. Check for each sample if the required sample volume of 500 μl plus dead 
volume of the sample tube used is available.
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NOTE

Insufficient sample volume (e.g. due to lack of the required dead volume 
of the sample tube) will lead to the exclusion of the sample in the 
Purification Run.

7. Tick the Predilution checkbox if the sample needs to be prediluted during 
the sample preparation procedure (see chapter 10.6.1 Sample Preparation) to 
provide the required sample volume.

• The Sample Volume field and Added Diluent field will appear (see 
Figure 5), each with 500 μl as preset volumes.

• Change the preset volumes of 500 μl in the Sample Volume field and 
Added Diluent field to match the volumes that will be used during the 
sample preparation.

Figure   5: Add Samples dialog: Ticked Predilution checkbox
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NOTE

The predilution will be included in the Concentration Factor, which is 
reported in the PCR results to calculate the target concentration in the 
original sample from the PCR results (see chapter 10.21.6.1 Manual 
Interpretation of Results). The calculation is either done by the user or 
by the LIMS during import of the PCR results.

NOTE

The predilution property of a sample can be edited after closing the Add 
Samples dialog by ticking the checkbox in the column Predilution of 
the sample table.

8. Click the Add button to add the sample to the sample table.

9. Repeat the steps above until all samples are added to the sample table. 

10. When all samples are added, click the Close button to close the Add 
Samples dialog. The added samples are displayed in the sample table of the 
Programming Screen (see Figure 6).

Figure   6: Programming Screen with added samples
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NOTE

The sample list can be sorted by individual columns by clicking the 
column header. Multiple samples can be selected by holding down 
the Shift-Key or Ctrl-Key while clicking on sample lines. The selected 
samples can be modified collectively by clicking the wrench symbol in 
the appropriate column header. Samples can be removed from the list 
by selecting them and clicking the Delete button in the tool bar.

11. Assign the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 assay to specific samples 
by clicking in the cell which is in the row of the respective sample and in the 
column of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 (see Figure 7). 

12. Select qualitative in the appearing menu.

Figure   7: Programming Screen: PCR Assay Assignment

The correct set of Standards and Controls is automatically selected. Additionally, 
the required sample volume for the Purification Run (dead volume not factored in) 
and the eluate volume that remains available for assignment to other assays are 
automatically adjusted in the sample list columns Sample Volume and Eluate left, 
respectively.



35

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

NOTE

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 settings: 

- Positive Control and NTC are selected. 

- The required sample volume is 500 μl plus the dead volume for the
respective sample tube (see chapter 7.3 Sample Volume). 

- The required eluate volume for the AltoStar® SARS-CoV-2 RT-PCR Kit 
1.5 is 10 μl.

NOTE

If it is not possible to select a PCR assay for a sample, check in the 
Eluate left column of the sample table, whether the eluate volume 
required for this assay is still available.

10.4.2  Importing from LIMS
Both the sample properties as well as the assay assignment can be imported from 
the LIMS. To do so, click the Import File button in the tool bar. In the dialog that 
opens, select the Import File (.psv) that contains the required information. 

For information regarding the LIMS integration, contact altona Diagnostics Technical 
Support (see chapter 14 Technical Assistance).
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10.5  Creating an AltoStar® Run
For processing the samples in the sample table must be assigned to an AltoStar® 
Run which includes the Purification Run as well as one or more PCR Setup Runs 
and PCR Runs for a given sample.

1. Tick the Sample Priority checkbox for samples that should be sorted to the 
same PCR Plate for fastest processing.
• Initially, all samples are ticked in the column Process Sample indicating 

that the respective samples are to be included in the AltoStar® Run 
generated next. 

• Above the sample table in the Programming Screen (see Figure 7), Wells 
used is displayed (showing the number of the AltoStar® Processing Plate 
wells needed for processing of the samples currently ticked in the column 
Process Sample). 

• Up to 96 wells can be used in one Purification Run.

NOTE

The AltoStar® Processing Plate is a consumable for Purification Runs 
and contains 96 wells that can be used for processing of samples. 
Samples with a processing volume of 1000 μl need two wells of the 
AltoStar® Processing Plate. Thus, the maximum number of samples that 
can be processed in one Purification Run varies and depends on the 
number of samples with a processing volume of 1000 μl.

• If the number of 96 wells is exceeded, the AltoStar® Run cannot be created 
and Wells used is displayed in red.

2. In this case, deselect samples in the column Process Sample until Wells 
used displays 96 or less. The remaining samples still ticked in the column 
Process Sample will be assigned to the next AltoStar® Run.

3. Click the Create Run button in the tool bar of the Programming Screen. The 
Save Run Definition dialog is displayed (see Figure 8).

NOTE

No further modifications to samples are possible after clicking the Create 
Run button. If changes to a created AltoStar® Run are necessary, the 
created AltoStar® Run has to be deleted and manual programming or 
the import from LIMS has to be repeated.



37

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

4. Enter a unique Run Name and optionally a Description for identification of the 
AltoStar® Run later on. 

5. Click the Ok button to save the AltoStar® Run.

Figure   8: Save Run Definition dialog

Samples that have been assigned to an AltoStar® Run are removed from the sample 
table of the Programming Screen. To create further AltoStar® Runs for the remaining 
samples in the sample table:

6. Select up to 96 of the remaining samples in the column Process Sample. 

7. Click the Create Run button and repeat the steps 4 and 5. 
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10.6  Starting a Purification Run
1. Select Purification → Start Purification in the menu bar. Alternatively, go 

back to the Start Screen of the AltoStar® Connect software and select the Start 
Purification button.
• The Start Purification Run Screen is displayed (see Figure 9). Each 

programmed AltoStar® Run includes one Purification Run. 

• The pending Purification Runs are displayed in the Programmed 
Purification Runs table on the left side of the screen.

Figure   9: Start Purification Run Screen

2. Select the Purification Run to be started in the Programmed Purification Runs 
table. The samples included in the selected Purification Run are displayed in 
the table on the right side of the screen (Samples in selected Purification 
Run).

Before clicking the Start Run button in the tool bar, prepare the samples of the 
selected Purification Run and the reagents as described in chapters 10.6.1 Sample 
Preparation and 10.6.2 Preparing Reagents for a Purification Run. 
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10.6.1  Sample Preparation
For correct results the specifications regarding sample type, sample collection, 
sample volume, sample tube and sample barcode (see chapter 7 Samples) as well 
as with respect to sample preparation have to be followed carefully.

1. Prepare all samples that shall be used in the next Purification Run. The samples 
required for the selected Purification Run are listed in the table (Samples in 
selected Purification Run) on the right side of the Start Purification Run 
screen.

2. Provide at least 500 µl sample volume plus the required dead volume in a 
suitable sample tube.

NOTE

The samples must be free of solids and high-viscosity constituents. 
Solids and high-viscosity constituents will interfere with the sample 
transfer on the AltoStar® AM16 and the samples will not be processed.

NOTE

The sample volume is not checked by the system prior to processing. 
Samples with insufficient volume will not be processed and error flagged 
during the sample transfer step.

NOTE

If the samples must be prediluted: Predilution diluent, which is not 
compatible with this application may affect nucleic acid stability, sample 
transfer and purification performance.

10.6.1.1  Respiratory Swabs
Respiratory swabs collected in universal transport medium, as described in 
chapter 7.2 Sample Collection and Handling, that are free of solids and high-viscosity 
constituents can be processed without pretreatment on the AltoStar® AM16.
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NOTE

When working with primary swab collection tubes make sure to remove 
the swab before loading the tube on the AltoStar® AM16. The swab 
might interfere with the sample transfer on the AltoStar® AM16 and the 
sample will not be processed.

10.6.2  Preparing Reagents for a Purification Run
1. Ensure to prepare sufficient amounts of non-expired reagents which all have to 

have the same Loading Number. 

The Loading Number consists of the last four lot number digits of the Lysis Buffer 
and Wash Buffer containers and the Magnetic Bead, Enhancer and Elution Buffer 
tubes.

NOTE

For your convenience, the 4-digit Loading Number (see Figure 10) is 
displayed on the outside of each component box.

Figure   10: Loading Number
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NOTE

Before processing starts the AltoStar® AM16 automatically verifies

1) that sufficient reagent volume of the AltoStar® Purification Kit 1.5 
components and of the AltoStar® Internal Control 1.5 is present, 

2) that the Loading Numbers of the loaded AltoStar® Purification Kit 1.5 
components are congruent.

2. Visibly inspect the Lysis Buffer for precipitates. In case precipitates are visible, 
heat it to below 50 °C. Intermittently pivot the container gently without wetting 
the seal until precipitates are completely dissolved. Slight color changes may 
occur to the Lysis Buffer. These slight changes in color do not indicate a change 
in the quality of the buffer. 

3. Vortex the Magnetic Bead tubes for 5 seconds. Avoid wetting the lid. Do not 
centrifuge the Magnetic Beads. 

4. Thaw the required number of IC tubes (AltoStar® Internal Control 1.5) 
completely and vortex for 5 seconds.

10.6.3  Instrument Loading for a Purification Run
1. Click the Start Run button in the tool bar of the Start Purification Run screen to 

display the Loading dialog (see Figure 11).

The Loading dialog consists of a visual representation of the AltoStar® AM16 deck 
at the top and a table specifying the carrier, the respective tracks on the AltoStar® 
AM16 deck for each carrier, the material for each carrier and comments with respect 
to the carrier loading.
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Figure   11: Loading dialog
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NOTE

To visualize the position of an item on a carrier and the position of the 
carrier on the AltoStar® AM16 deck, select the respective row of the 
table in the Loading dialog. The position of the item and its carrier is 
visualized: 

1) Highlighted in red in the visual representation of the instrument deck. 

2) On the AltoStar® AM16 by flashing Loading Lights above the tracks 
where the selected carrier must be placed.

2. Load the material, prepared reagents and prepared samples onto the suitable 
carriers as follows:

Track Carrier Description Material to be loaded

1 - 6

One Tip Carrier

5 x 1000 μl Tip Racks

• Exchange only completely empty 1000 μl Tip Racks for completely full 
1000 μl Tip Racks on the Tip Carrier.

NOTE

Exchange of Tip Racks, which are not completely empty as well 
as handling of individual tips may interfere with the automatic tip 
management and cause run aborts.
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Track Carrier Description Material to be loaded

7 - 12

One Tip and Plate Carrier

3 x 300 μl Tip Racks

1 x Eluate Plate

• Exchange only completely empty 300 μl Tip Racks for completely full 
300 μl Tip Racks on the Tip and Plate Carrier.

• Place the Eluate Plate with well A1 to the left of the black plate position. The 
plate position at the front is not used during Purification Runs.

NOTE

Exchange of Tip Racks, which are not completely empty as well 
as handling of individual tips may interfere with the automatic tip 
management and cause run aborts.
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Track Carrier Description Material to be loaded

13 - 16

One or two Container 
Carriers

up to 8 containers of:

Lysis Buffer

Wash Buffer 1

Wash Buffer 2

Wash Buffer 3

• Load one or two Container Carriers with up to eight containers of Lysis 
Buffer, Wash Buffer 1, Wash Buffer 2 and Wash Buffer 3.

• Gently push the containers all the way to the bottom of the carrier.

• Remove and dispose of all sealing foils from the containers.

NOTE

Starting a Purification Run with the sealing foils still on the containers 
may cause the run to abort during processing.

NOTE

The position of the individual containers on the respective carriers is 
arbitrary.
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Track Carrier Description Material to be loaded

17

One Tube Carrier 24

up to 24 tubes of:

IC (Internal Control)

Magnetic Beads

Enhancer

Elution Buffer

• Load a Tube Carrier 24 with up to 24 tubes of IC, Magnetic Beads, Enhancer 
and Elution Buffer.

• Gently push the tubes all the way to the bottom of the carrier and rotate 
the tubes until the tube barcodes are visible through the carrier windows.

• Remove all lids from the tubes and store them for reuse.

• Store the lids for reuse in a clean space.

NOTE

Reuse of lids for any other tube than the original one may lead to cross-
contamination.

NOTE

The position of the individual tubes on the carrier is arbitrary.

NOTE

Starting a Purification Run with lids still on the tubes may cause the run 
to abort during processing.
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Track Carrier Description
Material to be 

loaded

18 - 23

One to six Tube 
Carrier 32 for sample 
tubes of 11 - 14 mm 

diameter

One to six Tube 
Carrier 24 for sample 

tubes of 
14.5 - 18 mm 

diameter

Prepared samples for 
the Purification Run 

to be started

• Load the prepared samples for the Purification Run on up to six sample 
carriers. Two carrier types can be used in parallel in the same run:

 ◦ For sample tubes of 11 - 14 mm outer diameter use the Tube Carrier 32.

 ◦ For sample tubes of 14.5 - 18 mm outer diameter use the Tube Carrier 
24.

• Gently push the tubes all the way to the bottom of the carrier and rotate 
the tubes until the tube barcodes are visible through the carrier windows.

NOTE

The position of the individual tubes on the carriers is arbitrary.

NOTE

Starting a Purification Run with lids still on the tubes may cause the run 
to abort during processing.
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Track Carrier Description Material to be loaded

24 - 30

Heater Shaker Carrier 

This carrier is not removable. 
The items are placed by 

hand onto the carrier in the 
instrument.

1 x AltoStar® Processing 
Plate

1 x Tip Park Plate

1 x Tip Park Rack

• Place an unused Tip Park Plate at the bottom of the front position and an 
unused Tip Park Rack at the top of the front position and ensure both items 
are latched into their respective position.

• Place an unused AltoStar® Processing Plate at the second position from 
the front and ensure it is latched into position.

3. Load the carriers with the carrier barcode towards the rear facing right.

4. Insert populated carriers into the respective tracks between the front and rear 
slide blocks of the Loading Tray until they touch the stop hooks on the far side 
of the Loading Tray.

NOTE

Pushing the carriers past the stop hooks may damage the instrument 
and interfere with the loading process. 

5. Check that the Tip Eject Sheet and the Tip Waste Container are in the correct 
position and a new Waste Bag is placed in the container.

6. Click Ok in the Loading dialog to proceed with the loading process.
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NOTE

By clicking Cancel the Purification Run will be cancelled, but it can be 
started again (see chapter 10.6 Starting a Purification Run).

The Tip Park Plate dialog is displayed (see Figure 12).

Figure   12: Tip Park Plate dialog
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7. Scan the Tip Park Plate barcode in duplicate with the handheld barcode 
scanner to ensure that the plate has not been used in prior runs.

8. Click Ok to confirm the input.

The AltoStar® AM16 draws the carriers into the instrument and performs barcode 
and reagent volume verifications.

NOTE

The AltoStar® AM16 automatically verifies: 

1) Correct type and localization of the loaded carriers

2) Correct identity and position of the items loaded on the carriers

3) Lot congruence of the AltoStar® Purification Kit 1.5 components (Lysis 
Buffer, Wash Buffers, Magnetic Beads, Enhancer and Elution Buffer)

4) Non-expiry of all loaded reagents

5) Presence of sufficient reagent volumes

6) Singularity of sample barcodes

7) Correct positioning of the items loaded manually on the Heater 
Shaker Carrier

8) Correct positioning of the Tip Eject Sheet

If any of these checks fail, the user is prompted with a message dialog specifying 
the problem at hand and instructions to correct the issue accordingly. For further 
information regarding error handling refer to the AltoStar® Connect Software Manual 
IVD (Hamilton, chapter 4 Troubleshooting and Error Messages).

NOTE

Altering of positions of any loaded item after the carrier has been drawn 
into the instrument results in abort of the Purification Run and damage 
to the instrument.

When all checks have passed the Loading complete dialog is displayed (see 
Figure 13).
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Figure   13: Loading complete dialog

9. Confirm the Loading complete dialog by clicking Ok or wait 10 seconds for 
the automatic start of the process.

NOTE

By clicking Cancel the Purification Run will be cancelled, but it can be 
started again (see chapter 10.6 Starting a Purification Run).

The Purification Run is started and will be conducted without user intervention.

10.7  During the Purification Run
No further user interaction is required until the Purification Run has finished. The 
Processing Status Screen is displayed (see Figure 14) showing the status of the 
Purification Run and the estimated time remaining.
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Figure   14: Processing Status Screen

NOTE

Pushing or pulling carriers or the door of the AltoStar® AM16 during a 
Purification Run may abort the run.

NOTE

Aborting the Purification Run after the Loading complete dialog is 
confirmed will void the AltoStar® Run, preventing a restart. To repeat 
aborted runs see the AltoStar® Connect Software Manual IVD (Hamilton, 
chapter 3.8.14 Purification Results).

NOTE

After the sample transfer into the AltoStar® Processing Plate has 
finished, the sample carrier(s) can be unloaded at any time. The Unload 
samples button in the tool bar will be active and can be clicked. The 
sample carrier(s) will be unloaded from the deck and the sample tubes 
can be removed. The Purification Run will not be interrupted.
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NOTE

Required components of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 
for the subsequent PCR Setup Run can be previewed to allow for 
preparation of these components during the preceding Purification Run: 

1. Click PCR Setup → Start PCR Setup in the menu bar to access the 
Start PCR Setup Run Screen.

2. Refer to the tables Controls in selected PCR Setup Run and 
Required master tubes for the selected PCR Setup Run for 
information on the required components. 

3. Return to the ongoing Purification Run by clicking Purification → 
Current Purification in the menu bar.

10.8  End of the Purification Run
At the end of the Purification Run the Run finished dialog is displayed (see 
Figure 15).

Figure   15: Run finished dialog

1. Make sure that the Loading Tray is empty.

2. Confirm the Run finished dialog by clicking Ok.
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The AltoStar® AM16 will unload the carriers. Make sure not to stand in the way of 
the unloading carriers. 

After unloading the Maintenance dialog is displayed (see Figure 16). 

3. Follow the instructions of the Maintenance dialog.

Figure   16: Maintenance dialog

The table of the dialog displays components of the AltoStar® Purification Kit 1.5 and 
the IC (AltoStar® Internal Control 1.5) with sufficient volume to be used again in 
subsequent Purification Runs.

1. If a PCR Setup Run using the currently loaded Eluate Plate is to be started 
directly after the Purification Run, the Eluate Plate can remain on the carrier 
position at room temperature (max. 30 °C) up to 6 hours. If the PCR Setup Run 
is not started directly after the Purification Run, seal and store the Eluate Plate 
as described in chapter 10.10.2 Sealing of the Eluate Plate.

2. Close tubes with the appropriate tube caps. Avoid interchanging the tube caps 
when closing the reagents after use.

3. Close containers with unused AltoStar® Container Re-Sealing Foils.

4. Store reagents for reuse as described in the chapters 4 Storage and Handling 
in the Instructions for Use of the AltoStar® Purification Kit 1.5 and the AltoStar® 
Internal Control 1.5, respectively.
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5. Dispose of the components of the AltoStar® Purification Kit 1.5 and the AltoStar® 
Internal Control 1.5 not listed in the table. 

Dispose of the samples and used materials (see chapter 11 Disposal).

6. Confirm the Maintenance dialog by clicking Ok.

CAUTION

Always treat samples as infectious and (bio-)hazardous in accordance 
with safe laboratory procedures. For sample material spills promptly 
use an appropriate disinfectant. Handle contaminated materials as 
biohazardous.

NOTE

Liquid waste and any liquids containing Lysis Buffer or Wash Buffer 1 
contain guanidine thiocyanate, which can form toxic, highly reactive and 
volatile compounds when combined with bleach or strong acids.

NOTE

The instructions for the daily maintenance procedure for the disposal 
of liquid waste and used materials can be found in the AltoStar® AM16 
Operator´s Manual IVD (Hamilton, chapter 3.5 Maintenance).
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10.9  Purification Run Results
The Purification Run results are saved in the AltoStar® Connect software.

1. Click Purification → Purification Results in the menu bar to access the 
Results Screen (see Figure 17).

Figure   17: Results Screen

The Results Screen displays a table with all samples used in the latest Purification 
Run and a column Status at the right showing if the Purification Run for a given 
sample was conducted completely (see Table 5).
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Table   5: Purification Run Results

Status Purification Run Result

Processed
• The sample was successfully processed in the Purification Run.
• The respective eluate is ready for use in a PCR Setup Run.

Error

• The sample was not processed successfully.
• No eluate of this sample is available. 
• The sample will be automatically omitted from following PCR Setup 

Runs. 

2. To view the results of prior Purification Runs, click the Load button in the 
menu bar, select the desired Purification Run from the list in the opening Load 
Results dialog and click Ok.

Two Purification Run result files are automatically generated by the AltoStar® 
Connect software:

• A LIMS file (.xml) to pass detailed information about the Purification Run 
including results back to the LIMS. 

• A report (.pdf) containing detailed information about the Purification Run 
including results for documentation purposes.

These files are saved to the location specified in the System Settings of the AltoStar® 
Connect software.

NOTE

Purification Run result files can be generated again by loading the 
respective Purification Run and clicking the Create LIMS File button 
to generate the LIMS file or the Create Report button to generate the 
report.
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10.10  Eluate Stability
After completion of the Purification Run the eluates in the unsealed Eluate Plate are 
stable at room temperature (max. 30 °C) for a total of 6 hours.

CAUTION

Storage of eluates under wrong conditions may lead to degradation of 
the SARS-CoV-2 target sequence.

10.10.1  Storage
The eluates in a sealed Eluate Plate (see chapter 10.10.2 Sealing of the Eluate 
Plate) can be stored at 2 °C to 8 °C for up to 24 hours before the start of a PCR 
Setup Run.

CAUTION

Storage of eluates under wrong conditions may lead to degradation of 
the SARS-CoV-2 target sequence.

10.10.2  Sealing of the Eluate Plate
In case the eluates in the Eluate Plate are to be stored, the plate must be sealed 
with AltoStar® Eluate Plate Sealing Foil. It is recommended to use the AltoStar® 
Plate Sealer. The suitability of plate sealers other than the AltoStar® Plate Sealer 
has to be evaluated by the user.

NOTE

Using unsuitable plate sealers or sealing parameters may damage the 
eluates as well as the Eluate Plate, the AltoStar® Eluate Plate Sealing 
Foil and the plate sealer.

 



59

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

If the AltoStar® Plate Sealer is used for sealing, proceed as follows:

1. Turn on the AltoStar® Plate Sealer and make sure that the plate adapter is not 
in the drawer.

2. Ensure that the settings of the AltoStar® Plate Sealer are as follows: 170 °C 
and 2 seconds.

3. Wait until the set temperature of 170 °C is reached. This may take several 
minutes. 

4. Place the Eluate Plate on the plate adapter of the AltoStar® Plate Sealer. 

5. Place one AltoStar® Eluate Plate Sealing Foil on the Eluate Plate. Align the cut 
corner of the sealing foil with the cut corner of the Eluate Plate. Make sure that 
all wells of the Eluate Plate are covered with foil. Please take special care that 
the well at the cut corner is covered properly.

NOTE

Operating the AltoStar® Plate Sealer without the plate adapter placed 
in the drawer may render the sealer nonfunctional. In this case contact 
altona Diagnostics Technical Support for assistance (see chapter 14 
Technical Assistance).

NOTE

If the AltoStar® Eluate Plate Sealing Foil or the frame is placed incorrectly, 
the foil may stick to the heating plate within the AltoStar® Plate Sealer 
during sealing. This will render the sealer nonfunctional. In this case let 
the AltoStar® Plate Sealer cool down to room temperature and contact 
altona Diagnostics Technical Support for assistance (see chapter 14 
Technical Assistance).

6. Assemble the sealing frame on top to hold down the sealing foil. 

7. Open the drawer via the Operate button. 

8. Place the assembly consisting of the plate adapter, the Eluate Plate, the 
AltoStar® Eluate Plate Sealing Foil and the sealing frame into the AltoStar® 
Plate Sealer and press the Operate button. 

9. The drawer closes automatically, seals for 2 seconds and reopens automatically. 

10. Take the sealed Eluate Plate and the plate adapter out of the AltoStar® Plate 
Sealer and close the AltoStar® Plate Sealer by pressing the Close button.
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10.10.3  Unsealing of the Eluate Plate
Remove the AltoStar® Eluate Plate Sealing Foil from the Eluate Plate as follows:

1. Briefly centrifuge the Eluate Plate in a plate centrifuge to remove any liquid 
from the inside of the sealing foil. 

2. Press the Eluate Plate onto a table to avoid sudden plate movements during 
the removal of the sealing foil. 

3. Start peeling in one corner and slowly and steadily pull the sealing foil towards 
the diagonally opposite corner until it is removed.

10.11  Starting a PCR Setup Run
1. Select PCR Setup → Start PCR Setup in the menu bar. Alternatively, go back 

to the Start Screen of the AltoStar® Connect software and select the Start PCR 
Setup button. The Start PCR Setup Run Screen is displayed (see Figure 18).

The pending PCR Setup Runs are displayed in the Programmed PCR Setup Runs 
table on the left side of the screen.
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Figure   18: Start PCR Setup Run Screen

2. Select the PCR Setup Run to be started in the Programmed PCR Setup Runs 
table. 

• The samples included in the selected PCR Setup Run are displayed in the 
table on the top right side of the screen (Samples in selected PCR Setup 
Run).

• The Controls required for the selected PCR Setup Run are displayed in 
the table on the middle right side of the screen (Controls in selected PCR 
Setup Run).

• The number of master tubes required for the selected PCR Setup Run is 
displayed in the table on the bottom right side of the screen (Required 
master tubes for the selected PCR Setup Run).
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NOTE

The number of prioritized samples in a PCR Setup Run is displayed 
in the column No. of prioritized Samples. Conduct PCR Setup Runs 
with prioritized samples first to facilitate fastest processing of prioritized 
samples.

Before clicking the Start Run button in the tool bar, prepare the required reagents 
as described in chapter 10.12 Preparing Reagents for a PCR Setup Run. If the 
Eluate Plate required for the selected PCR Setup Run has been sealed for storage 
prepare it as described in chapter 10.10.3 Unsealing of the Eluate Plate.

10.12  Preparing Reagents for a PCR Setup Run
1. Thaw the required Controls and the required number of Master tubes completely 

at room temperature (max. 30 °C). 

2. Mix the reagents by gentle vortexing. 

3. Centrifuge the tubes briefly to remove drops from the lid.

CAUTION

A lack of centrifugation of the product components after thawing could 
lead to contamination of the components with reagent residues in the 
lids and as consequence to a compromised product performance.
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10.12.1  Loading the AltoStar® AM16 for a PCR Setup Run
1. Click the Start Run button in the tool bar of the Start PCR Setup Run Screen 

to display the Loading dialog (see Figure 19).

Figure   19: Loading dialog
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The Loading dialog consists of a visual representation of the AltoStar® AM16 
deck at the top and a table specifying the carriers, the respective tracks on the 
AltoStar® AM16 deck for each carrier, the material to be loaded onto each carrier 
and comments with respect to the carrier loading.

NOTE

To visualize the position of an item on a carrier and the position of the 
carrier on the AltoStar® AM16 deck, select the respective row of the table 
in the Loading dialog. 

The position of the item and its carrier is visualized: 

1) Highlighted in red in the visual representation of the instrument deck. 

2) On the AltoStar® AM16 by flashing Loading Lights above the tracks 
where the selected carrier must be placed.

2. Load the required material, the prepared Eluate Plate and the prepared 
reagents onto the suitable carriers as follows:

Track Carrier Description Material to be loaded

1 - 6

One Tip Carrier

5 x 1000 µl Tip Racks

• Exchange only completely empty 1000 μl Tip Racks for completely full 
1000 μl Tip Racks on the Tip Carrier.
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NOTE

Exchange of Tip Racks, which are not completely empty as well 
as handling of individual tips may interfere with the automatic tip 
management and cause run aborts.

Track Carrier Description Material to be loaded

7 - 12

One Tip and Plate Carrier

3 x 300 μl Tip Racks 

1 x Eluate Plate 

1 x PCR Plate

• Exchange only completely empty 300 μl Tip Racks for completely full 
300 μl Tip Racks on the Tip and Plate Carrier. 

• Place the required Eluate Plate with well A1 to the left of the black plate 
position. 

• Place a PCR Plate with well A1 to the left of the silver front plate position.

NOTE

Exchange of Tip Racks, which are not completely empty as well 
as handling of individual tips may interfere with the automatic tip 
management and cause run aborts.
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Track Carrier Description Material to be loaded

13

One Tube Carrier 24

1 Pooling Tube per assay

• Load a Tube Carrier 24 with one unused Pooling Tube for each assay in 
the PCR Setup Run. 

• Gently push the tubes all the way to the bottom of the carrier and rotate the 
tubes until the tube barcodes are visible through the carrier window.

NOTE

The position of the individual tubes on the carrier is arbitrary.
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Track Carrier Description Material to be loaded

14 - 17

One to four Reagent Tube 
Carrier 32

Assay components

• Load the Reagent Tube Carrier 32 with the assay components required for 
the PCR Setup Run.

• Gently push the tubes all the way to the bottom of the carrier and rotate the 
tubes until the tube barcodes are visible through the carrier window.

NOTE

The position of the individual tubes on the carriers is arbitrary.

NOTE

The volume of the loaded components is not checked by the system prior 
to processing. Insufficient component volume will prevent successful 
PCR setup for the affected assay.

NOTE

Starting a PCR Setup Run with lids still on the tubes may cause the run 
to abort during processing.
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3. Load the carriers with the carrier barcode towards the rear facing right. 

4. Insert populated carriers into the respective tracks between the front and rear 
slide blocks of the Loading Tray until they touch the stop hooks on the far side 
of the Loading Tray.

NOTE

Pushing the carriers past the stop hooks may damage the instrument 
and interfere with the loading process.

5. Check that the Tip Eject Sheet and the Tip Waste Container are in the correct 
position and a new Waste Bag is placed in the container. 

6. Click Ok in the Loading dialog to proceed with the loading process.

NOTE

By clicking Cancel the PCR Setup Run will be cancelled, but it can be 
started again (see chapter 10.11 Starting a PCR Setup Run).

The AltoStar® AM16 draws the carriers into the instrument and performs barcode 
verification.

NOTE

The AltoStar® AM16 automatically verifies: 

1) Correct type and localization of the loaded carriers. 

2) Correct identity and position of the items loaded on the carriers. 

3) Lot congruence of the components of the individual AltoStar® assay 
kits. 

4) Non-expiry of all loaded AltoStar® assay components. 

5) Correct positioning of the Tip Eject Sheet.
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If any of these checks fail, the user is prompted with a message dialog specifying 
the problem at hand and instructions to correct the issue accordingly. For further 
information regarding error handling refer to the AltoStar® Connect Software Manual 
IVD (Hamilton, chapter 4 Troubleshooting and Error Messages).

NOTE

Altering positions of any loaded item after the carrier has been drawn 
into the instrument may result in the abort of the PCR Setup Run and/or 
damage to the instrument.

When all checks have passed the Loading complete dialog is displayed (see 
Figure 20).

Figure   20: Loading complete dialog

7. Confirm the Loading complete dialog by clicking Ok or wait 10 seconds for 
the automatic start of the process.

NOTE

By clicking Cancel the PCR Setup Run will be cancelled, but it can be 
started again (see chapter 10.11 Starting a PCR Setup Run).

The PCR Setup Run is started and will be conducted without user intervention.
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10.13  During the PCR Setup Run
No further user interaction is required until the PCR Setup Run has finished. The 
Processing Status Screen is displayed (see Figure 21) showing the status of the 
PCR Setup Run and the estimated time remaining.

Figure   21: Processing Status Screen

NOTE

Pushing or pulling carriers or the door of the AltoStar® AM16 during a 
PCR Setup Run may abort the run.
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10.14  End of the PCR Setup Run
At the end of the PCR Setup Run the Run finished dialog is displayed (see 
Figure 22).

Figure   22: Run finished dialog

1. Make sure that the Loading Tray is empty.

2. Confirm the Run finished dialog by clicking Ok.

The AltoStar® AM16 will unload the carriers. Make sure not to stand in the way of 
the unloading carriers.

After unloading the Maintenance dialog is displayed (see Figure 23).

3. Follow the instructions of the Maintenance dialog.
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Figure   23: Maintenance dialog

The table of the dialog displays the number of reactions in the Master tubes that 
were not used in the PCR Setup Run.

4. If another PCR Setup Run using the currently loaded Eluate Plate is to be 
started right away, the Eluate Plate can remain unsealed on the carrier position. 
If this is not the case, seal and store the Eluate Plate as described in chapter 
10.10.2 Sealing of the Eluate Plate.

NOTE

The eluates in the Eluate Plate are stable at room temperature 
(max. 30 °C) for a total of 6 hours after completion of the Purification 
Run.

5. Close reagent tubes with suitable unused tube caps.

CAUTION

Do not reuse tube caps to avoid contamination of the reagents.

6. Store reagents for reuse as described in chapter 4.2 Handling. 

7. Dispose of the used materials (see chapter 11 Disposal). 

8. Confirm the Maintenance dialog by clicking Ok.
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10.15  PCR Setup Run Results
The PCR Setup Run results are saved in the AltoStar® Connect software.

1. Click PCR Setup → PCR Setup Results in the menu bar to access the Results 
Screen (see Figure 24).

Figure   24: Results Screen

The Results Screen displays a table with all samples used in the latest PCR Setup 
Run and a column Status at the right showing if the PCR Setup process for a given 
sample was conducted completely (see Table 6).

Table   6: PCR Setup Run Results

Status PCR Setup Run Result

Processed
• The eluate was successfully processed in the PCR Setup Run.
• The resulting RT-PCR Mix is ready for use in a PCR Run. 

Error
• The eluate was not processed successfully.
• The respective RT-PCR Mix will be automatically omitted in the 

following PCR analysis. 
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2. To view the results of prior PCR Setup Runs, click the Load button in the 
menu bar, select the desired PCR Setup Run from the list in the opening Load 
Results dialog and click Ok.

Three PCR Setup Run result files are automatically generated by the AltoStar® 
Connect software:

• A LIMS file (.xml) to pass detailed information about the PCR Setup Run 
including results back to the LIMS 

• A report (.pdf) containing detailed information about the PCR Setup Run 
including results for documentation purposes 

• A cycler file (.plrn) for automatic programming of the CFX96™ DW Dx

These files are saved to the location specified in the System Settings of the AltoStar® 
Connect software.

NOTE

PCR Setup Run result files can be generated again by loading the 
respective PCR Setup Run and clicking the Create LIMS File button to 
generate the LIMS file, the Create Report button to generate the report 
or the Create Bio-Rad Cycler File button to generate the Cycler File.
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10.16  Sealing of the PCR Plate
After completion of the PCR Setup Run, the PCR Plate must be sealed with AltoStar® 
PCR Plate Sealing Foil. It is recommended to use the AltoStar® Plate Sealer. The 
suitability of plate sealers other than the AltoStar® Plate Sealer has to be evaluated 
by the user.

If the AltoStar® Plate Sealer is used for sealing, proceed as follows:

1. Switch on the AltoStar® Plate Sealer and make sure that the plate adapter is 
not in the drawer.

2. Ensure that the settings of the AltoStar® Plate Sealer are as follows: 170 °C 
and 2 seconds. 

3. Wait until the set temperature of 170 °C is reached. This may take several 
minutes. 

4. Place the PCR Plate on the plate adapter of the AltoStar® Plate Sealer. 

5. Place one AltoStar® PCR Plate Sealing Foil on the PCR Plate. Align the cut 
corner of the sealing foil with the cut corner of the PCR Plate. Make sure that 
all wells of the PCR Plate are covered with foil. Please take special care that 
the well at the cut corner is covered properly.

NOTE

Operating the AltoStar® Plate Sealer without the plate adapter placed 
in the drawer may render the sealer nonfunctional. In this case contact 
altona Diagnostics Technical Support for assistance (see chapter 14 
Technical Assistance).

NOTE

If the AltoStar® PCR Plate Sealing Foil or the frame is placed incorrectly, 
the foil may stick to the heating plate within the AltoStar® Plate Sealer 
during sealing. This will render the sealer nonfunctional. In this case let 
the AltoStar® Plate Sealer cool down to room temperature and contact 
altona Diagnostics Technical Support for assistance (see chapter 14 
Technical Assistance).

6. Assemble the sealing frame on top to hold down the sealing foil. 

7. Open the drawer by pressing the Operate button.
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8. Place the assembly consisting of the plate adapter, the PCR Plate, the AltoStar® 
PCR Plate Sealing Foil and the sealing frame into the AltoStar® Plate Sealer 
and press the Operate button. 

9. The drawer closes automatically, seals for 2 seconds and reopens automatically. 

10. Take the sealed PCR Plate and the plate adapter out of the AltoStar® Plate 
Sealer and close the AltoStar® Plate Sealer by pressing the Close button.

10.17  PCR Mix Stability
After completion of the PCR Setup Run the RT-PCR Mix in the sealed PCR Plate is 
stable at room temperature (max. 30 °C) for max. 30 minutes.

CAUTION

Do not exceed the PCR Mix storage time. This could lead to a 
compromised product performance.
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10.18  Starting a PCR Run
The PCR Run is performed on a CFX96™ DW Dx under control of the CFX 
Manager™ Dx software.

1. Switch on the CFX96™ DW Dx, the attached computer and the monitor. 

2. Start the CFX Manager™ Dx software. 

3. In the menu bar of the CFX Manager™ Dx software select File → Open → 
LIMS File… to open the Open LIMS File dialog (see Figure 25).

Figure   25: CFX Manager™ Dx software window

4. In the opening Open LIMS File dialog, make sure that the cursor is blinking in 
the File name field at the bottom (see Figure 26). If it is not, click into the File 
name field.
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Figure   26: Open LIMS File dialog

5. Scan the PCR Plate barcode with the handheld barcode scanner to 
automatically select and open the correct LIMS file. The Run Setup dialog is 
displayed (see Figure 27).

NOTE

All parameters required for the start of the PCR Run are transferred 
automatically from the AltoStar® Connect software to the CFX96™ DW 
Dx by means of the cycler file.
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6. Click Open Lid to open the lid of the CFX96™ DW Dx (see Figure 27).

Figure   27: Run Setup dialog

7. Briefly centrifuge the sealed PCR Plate to ensure all liquid is at the bottom of 
the wells. 

8. Insert the sealed PCR Plate into the heating block of the CFX96™ DW Dx with 
well A1 to the left side. 

9. Close the CFX96™ DW Dx by clicking the Close Lid button in the Run Setup 
dialog (see Figure 27). 

10. Start the PCR Run by clicking the Start Run button in the Run Setup dialog 
(see Figure 27).
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10.19  During the PCR Run
No user interaction is required until the PCR Run has finished. The Run Details 
dialog is displayed (see Figure 28) showing the status of the PCR Run and the 
estimated time remaining.

Figure   28: Run Details dialog

NOTE

Opening the lid of the CFX96™ DW Dx during a PCR Run by operating 
the button at the front of the lid or by clicking Open Lid in the Run 
Details dialog will abort the run and void all results.
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At the end of the PCR Run the Data Analysis window is displayed (see Figure 29).

Figure   29: Data Analysis window

10.20  Assigning Assays to Well Groups
The AltoStar® Workflow processes one or several PCR assays simultaneously on 
one PCR Plate. However, each assay must be analyzed separately by the user 
according to the Instructions for Use of the respective assay. 

To this end, all assays on a PCR Plate must be assigned to individual Well Groups 
in the CFX Manager™ Dx software by the user.
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1. In the Data Analysis window (see Figure 29) click the Plate Setup button in 
the tool bar and select View/Edit Plate. The Plate Editor dialog is displayed 
(see Figure 30).

Figure   30: Plate Editor dialog

2. In the Plate Editor dialog click Well Groups… in the tool bar. The Well Groups 
Manager dialog is displayed (see Figure 31).

3. Click the Add button. 

4. Type the name of the first assay in the text box.

5. Select all wells in the PCR Plate area that belong to the first assay (see 
Figure 31). The wells belonging to an individual assay can be identified in the 
Plate Editor dialog by the entry in the Biological Set field.
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Figure   31: Well Groups Manager dialog

6. Repeat steps 3 to 5 for all assays on the PCR Plate. 

7. Confirm Well Group assignment by clicking OK. The Well Groups Manager 
dialog closes. 

8. Close the Plate Editor dialog by clicking OK. 

9. Confirm to apply the changes by clicking Yes (see Figure 32).

Figure   32: Confirmation dialog
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10.21  PCR Data Analysis
The results of all assays (Well Groups) on the PCR Plate have to be analyzed in 
the sequence depicted in Figure 33.

Figure   33: PCR Data Analysis process
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In the Data Analysis window (see Figure 29) ensure to select the Well Group of the 
AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well Group drop-
down menu right next to the Well Group button (see Figure 34) of the toolbar. Do 
not use the “All Wells” Well Group.

Before analyzing the results ensure that the Well Group of the AltoStar® SARS-
CoV-2 RT-PCR Kit 1.5 contains all of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 
wells and no wells of other assays.

Figure   34: Well Group button and Well Group drop-down menu

NOTE

Combined analysis of more than one assay may lead to incorrect results.

CAUTION

As with any diagnostic test, results should be interpreted in consideration 
of all clinical and laboratory findings.

10.21.1  Baseline Correction
The baseline settings used by the CFX Manager™ Dx software may have to be 
corrected for individual wells of the assay (Well Group) under analysis.

1. In the Data Analysis Window (see Figure 29) ensure to select the Well Group 
of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well 
Group drop-down menu right next to the Well Group button (see Figure 34) 
of the toolbar.

2. At the left side of the Data Analysis window tick only the FAM checkbox for the 
E gene detection channel (see Figure 29). 
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3. In the menu bar of the Data Analysis window click Settings → Baseline 
Threshold… to open the Baseline Threshold dialog (see Figure 35). 

4. Click the ◊ symbol in the Baseline End column header once to sort the table 
by ascending Baseline End values. 

5. Select all lines that show a Baseline End value of 1 to 9 (see Figure 35).

Figure   35: Baseline Threshold dialog

6. Set the value in the End: field to 45 for the selected lines (see Figure 35). 

7. Confirm the settings by clicking OK. 

8. At the left side of the Data Analysis window untick the FAM checkbox and tick 
only the VIC checkbox for the Internal Control target detection channel. 

9. Repeat steps 3 to 7 for the VIC™ (Internal Control) and Cy5 (S gene) detection 
channels.
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10.21.2  Exclusion of Irregular PCR Signals
Valid results can only be derived from PCR signals that are free of signal artefacts, 
which may be caused e.g. by impurities or bubbles in the RT-PCR Mix. PCR signals 
that contain signal artefacts have to be excluded by the user.

1. In the Data Analysis window (see Figure 29) ensure to select the Well Group 
of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well 
Group drop-down menu right next to The Well Group button (see Figure 34) 
of the toolbar. 

2. Identify wells with irregular PCR signals (linear signal increase, signal spikes, 
etc.) in any of the FAM™ (E gene), the Cy5 (S gene) and the VIC™ (Internal 
Control) detection channels (see Figure 36).
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Figure   36: Data Analysis window: Irregular PCR signal
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3. Click each affected well with the right mouse button and select Well... → 
Exclude from Analysis (see Figure 37).

Figure   37: Data Analysis window: Exclude Well from Analysis
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4. The selected well is excluded from the analysis. No results will be generated 
for this well (see Figure 38).

Figure   38: Data Analysis window: Excluded well
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10.21.3  Setting of Thresholds
The thresholds for the FAM™ (E gene), the Cy5 (S gene) and the VIC™ 
(Internal Control) detection channels have to be set manually by the user according 
to the signals of the controls.

1. In the Data Analysis Window (see Figure 29) ensure to select the Well Group 
of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well 
Group drop-down menu right next to the Well Group button (see Figure 34) 
of the toolbar. 

2. At the left side of the Data Analysis window tick only the VIC checkbox for the 
detection channel of the Internal Control (see Figure 39).
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Figure   39: Data Analysis window: Setting the VIC™ threshold

3. Select only the NTC well in the plate view of the Data Analysis window (see 
Figure 39). 

4. Drag the threshold into the exponential area of the NTC signal (see Figure 39).
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NOTE

The NTC contains Internal Control Template, which leads to an Internal 
Control signal in a valid NTC well.

5. At the left side of the Data Analysis window untick the VIC checkbox and tick 
the FAM checkbox for the detection channel of E gene (see Figure 40).

Figure   40: Data Analysis window: Setting the FAM™ threshold
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6. Select only the wells containing the NTC and the Positive Control in the plate 
view of the Data Analysis window (see Figure 40). 

7. Drag the threshold well above the signal of the NTC into the exponential area 
of the Positive Control signal.

8. For the detection channel of S gene untick the FAM checkbox at the left side of 
the Data Analysis window and tick the Cy5 checkbox, respectively and repeat 
steps 6 and 7.

10.21.4  Exclusion of Wells Containing Invalid Data
Wells that do not contain valid data have to be excluded from result generation by 
the user.

1. In the Data Analysis window (see Figure 29) ensure to select the Well Group 
of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well 
Group drop-down menu right next to the Well Group button (see Figure 34) 
of the toolbar. 

2. Identify all wells containing invalid data. A well is invalid if any of the following 
conditions apply:

a) The complete run is invalid (see chapter 10.21.4.1 Validity of a Diagnostic 
PCR Run).

b) The well data does not meet the control conditions for a valid result (see 
chapter 10.21.4.2 Validity of Results for a Sample).

3. Click each well containing invalid data according to chapters 10.21.4.1 Validity 
of a Diagnostic PCR Run to 10.21.4.2 Validity of Results for a Sample with 
the right mouse button and select Well... → Exclude from Analysis (see 
Figure 41 and Figure 42).
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Figure   41: Data Analysis window: Invalid Well
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Figure   42: Data Analysis window: Exclude invalid Well from Analysis
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The selected well is excluded from the analysis. No results will be generated for this 
well (see Figure 43).

Figure   43: Data Analysis window: Excluded Well
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10.21.4.1  Validity of a Diagnostic PCR Run
A diagnostic PCR Run is valid, if the following control conditions are met:

Table   7: Control conditions for a valid PCR Run

Control Detection channel

FAM™ (E gene) Cy5 (S gene)
VIC™ 

(Internal Control)

Positive Control + + not applicable

NTC - - +

A diagnostic PCR Run is invalid, if:

• the run has not been completed

• any of the control conditions for a valid diagnostic PCR Run are not met.

In case of an invalid diagnostic PCR Run, exclude all wells from the analysis and 
repeat the AltoStar® Run starting from the original samples.

10.21.4.2  Validity of Results for a Sample
The result for an individual sample is invalid, if the signals in the VIC™ 
(Internal Control) detection channel, the FAM™ (E gene) and the Cy5 (S gene) 
detection channels are negative (see Table 8). In case of an invalid result for a 
sample, exclude the well from the analysis and repeat testing from the original 
sample or collect and test a new sample. 
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Table   8: Result validity

Detection Channel

Result Validity
FAM™ (E gene) Cy5 (S gene)

VIC™ 
(Internal Control)

+ + + / - Valid result*

+ - + / - Valid result*

- + + / - Valid result*

- - + Valid result

- - - Invalid result

* Detection of the Internal Control is not required when either E gene or S gene is detected. A 
high RNA load of E gene or S gene in the sample can lead to a reduced or absent Internal 
Control signal.

10.21.5  Export of PCR Results for Automated Result Interpre-
tation

To make the PCR Run results available to a connected LIMS for automated result 
interpretation they need to be exported in the form of a LIMS Result File (.csv).

1. In the Data Analysis window (see Figure 29) ensure to select the Well Group 
of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well 
Group drop-down menu right next to the Well Group button (see Figure 34) 
of the toolbar.

2. Ensure that all steps of the analysis process (see chapters 10.21.1 Baseline 
Correction to 10.21.4 Exclusion of Wells Containing Invalid Data) have been 
completed for the Well Group of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5.

3. In the menu bar of the Data Analysis window click Export → Export All Data 
Sheets to open the Browse For Folder dialog (see Figure 44).
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Figure   44: Browse For Folder dialog

4. In the Browse For Folder dialog specify the location for the LIMS Result Files 
to be generated and click OK.

NOTE

The LIMS Integration has to be implemented according to the 
specifications of altona Diagnostics. For information regarding 
LIMS integration, contact altona Diagnostics Technical Support (see 
chapter 14 Technical Assistance).

NOTE

Saving results of more than one assay (Well Group) from a PCR Run 
in the same folder leads to replacement of the LIMS Result Files of the 
first assay (Well Group) with the LIMS Result Files of the second assay 
(Well Group). In this case the LIMS Result Files of the first assay (Well 
Group) can be exported again.
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10.21.6  Export of PCR Results for Manual Result Interpreta-
tion

If the results are not passed to a LIMS for automatic result interpretation, the result 
interpretation has to be performed manually by the user. To this end the analysis 
results of each assay (Well Group) need to be exported in the form of a Report.

1. In the Data Analysis Window (see Figure 29) ensure to select the Well Group 
of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. Therefore, click on the Well 
Group drop-down menu right next to the Well Group button (see Figure 34) 
of the toolbar. 

2. At the left side of the Data Analysis window tick the VIC checkbox as well as 
the FAM and Cy5 checkbox.

3. Ensure that all steps of the analysis process (see chapters 10.21.1 Baseline 
Correction to 10.21.4 Exclusion of Wells Containing Invalid Data) have been 
completed for the Well Group of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5.

4. In the menu bar of the Data Analysis window click Tools → Reports... to open 
the Report dialog (see Figure 45).



102

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

Figure   45: Report dialog: Export of the results as Report
 



103

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

5. Ensure that at least the following content is selected for report generation in the 
upper left part of the Report dialog (see Figure 46):

Figure   46: Report Dialog

Select or deselect additional content of the Report by ticking the respective check 
boxes as required.

6. In the menu bar of the Report dialog click File → Save As... to open the Save 
Report dialog.

7. In the Save Report dialog specify the name and location for the report file to 
be generated and click Save.

10.21.6.1  Manual Interpretation of Results
1. Open the Report file generated for the Well Group of the AltoStar® SARS-

CoV-2 RT-PCR Kit 1.5 (see chapter 10.21.6 Export of PCR Results for Manual 
Result Interpretation). 

2. Refer to the Quantification Data table in the Report (see Figure 47). The table 
comprises four rows for each Sample - one each for the Target E gene and S 
gene and one for the Target Internal Control.
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Figure   47: Report: Quantification Data

Qualitative results would be marked by the term qualitative in the Well Note column 
of the Quantification Data table (see Figure 47).

3. In that case, identify each row with the Target E gene or S gene and the term 
qualitative in the Well Note column. 

4. In these rows, refer to the Cq column for the result of the respective Sample. 

5. Refer to Table 9 for interpretation of results.
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Table   9: Result Interpretation

Detection Channel

Result InterpretationFAM™ 
(E gene)

Cy5 
(S gene)

VIC™ 
(Internal 
Control)

+ + +*
Lineage B-βCoV and SARS-CoV-2 specific RNA 
detected. Positive for SARS-CoV-2.

+ - +*
Only lineage B-βCoV specific RNA detected. 
Presumptive positive for SARS-CoV-2.1,2

- + +*
Only SARS-CoV-2 specific RNA detected. 
Positive for SARS-CoV-2.1

- - +

Neither lineage B-βCoV nor SARS-CoV-2 
specific RNA detected. The sample does not 
contain detectable amounts of SARS-CoV-2 
specific RNA.

- - -
RT-PCR inhibition or reagent failure. Repeat 
testing from original sample or collect and test a 
new sample.

* Detection of the Internal Control in the VIC™ detection channel is not required for positive 
results either in the FAM™ detection channel or in the Cy5 detection channel. A high lineage 
B-βCoV (target E gene) and/or SARS-CoV-2 (target S gene) RNA load in the sample can 
lead to reduced or absent Internal Control signals.

1 Detection in only one of the two respective detection channels for E gene and S gene might 
be due to low viral RNA concentration close to the limit of detection or due to mutation of one 
of the two target sequences.

2 Sample may be re-tested by repeating the extraction and RT-PCR. If the repeated result 
remains presumptive positive then additional confirmatory testing may be conducted.
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11.  Disposal
Dispose of hazardous and biological waste in compliance with local and national 
regulations. Leftover product components and waste should not be allowed to enter 
sewage, water courses or the soil.

CAUTION

Always treat samples as infectious and (bio-)hazardous in accordance 
with safe laboratory procedures. For sample material spills promptly 
use an appropriate disinfectant. Handle contaminated materials as 
biohazardous.

CAUTION

Dispose of hazardous and biological waste only in compliance with local 
and national regulations to avoid environmental contamination.

NOTE

Liquid waste and any liquids containing Lysis Buffer or Wash Buffer 1 
contain guanidine thiocyanate, which can form toxic, highly reactive and 
volatile compounds when combined with bleach or strong acids.

NOTE

The PCR Plate must be disposed of in sealed state, since the AltoStar® 
PCR Plate Sealing Foil cannot be removed.

 



107

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

12.  Performance Evaluation
The performance evaluation of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 was 
performed using heat inactivated SARS-CoV-2 cell culture supernatant (BetaCoV/
Munich/ChVir984/2020 provided by the Institute of Virology, Charité, Berlin; 
Germany).

12.1  Respiratory Swabs

12.1.1  Analytical Sensitivity
For the determination of the limit of detection (LoD) a dilution series of heat inactivated 
SARS-CoV-2 cell culture supernatant (BetaCoV/Munich/ChVir984/2020 provided 
by the Institute of Virology, Charité, Berlin; Germany) diluted in Universal Transport 
Medium™ (UTM®, Copan) containing simulated nasal matrix [5 % w/v Mucin, 5 % 
v/v blood, 0.8 % v/v NaCl (95 % saline) and 0.00002 % w/v human genomic DNA 
(510k Submission for BD MAX™ MRSA XT assay; accession number: K133605)] 
was generated.

Each dilution was tested in 8 replicates on 3 different days (total n = 24 per dilution) 
using combinations of 3 AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 lots, 3 AltoStar® 
Purification Kit 1.5 lots and 3 AltoStar® Internal Control 1.5 lots. Runs were performed 
using 3 different AltoStar® Automation System AM16 and CFX96™ DW Dx. 

Data from all runs were combined and a probit analysis was performed to determine 
the 95 % LoD value.
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Table   10: PCR results used for the calculation of the analytical sensitivity for E gene

Concentration [PFU/ml] N [total] N [positive] Hit rate [%]

1.00E+00 24 24 100

3.16E-01 24 24 100

1.00E-01 24 24 100

3.16E-02 24 24 100

1.00E-02 24 21 88

3.16E-03 24 12 50

1.00E-03 24 4 17

3.16E-04 24 1 4

1.00E-04 24 2 8

The limit of detection of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 for the detection 
of SARS-CoV-2 in UTM® containing simulated nasal matrix is 0.025 PFU/ml (95 % 
confidence interval: 0.014 - 0.060 PFU/ml).

Table   11: PCR results used for the calculation of the analytical sensitivity for S gene

Concentration [PFU/ml] N [total] N [positive] Hit rate [%]

1.00E+00 24 24 100

3.16E-01 24 24 100

1.00E-01 24 24 100

3.16E-02 24 24 100

1.00E-02 24 23 96

3.16E-03 24 15 63

1.00E-03 24 4 17

3.16E-04 24 2 8

1.00E-04 24 1 4
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The limit of detection of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 for the detection 
of SARS-CoV-2 in UTM® containing simulated nasal matrix is 0.014 PFU/ml (95 % 
confidence interval: 0.008 - 0.032 PFU/ml).

12.1.2  Analytical Specificity
The analytical specificity of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is ensured 
by the thorough selection of the oligonucleotides (primers and probes). The 
oligonucleotides were checked by sequence comparison analysis against publicly 
available sequences to ensure that all relevant SARS-CoV-2 genotypes will be 
detected.

For the verification of the analytical specificity of the AltoStar® SARS-CoV-2 
RT-PCR Kit 1.5 the following experiments were performed (see chapters 12.1.2.1 
Negative Samples to 12.1.2.4 Cross Reactivity):

12.1.2.1  Negative Samples
35 SARS-CoV-2 negative respiratory swab samples from individual donors were 
tested with the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5. All (35 out of 35) samples were 
tested negative for SARS-CoV-2 specific RNA and positive for the Internal Control. 
The analytical specificity of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 for respiratory 
swab samples is ≥ 95 %. 

12.1.2.2  Interfering Substances
To evaluate the influence of potentially interfering exogenous substances on the 
performance of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 selected substances 
were spiked in UTM® containing simulated nasal matrix and SARS-CoV-2 in a 
concentration of the 3 x LoD (0.75 PFU/ml) and no SARS-CoV-2, respectively.
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Results obtained for samples containing potentially interfering substances were 
compared to results generated for UTM® containing simulated nasal matrix 
without spiked interferent. Each sample was processed in 3 replicates. No 
interference was observed for samples containing elevated levels of exogenous 
[decongestant nasal spray; Xylometazolinhydrochloride and Dexpanthenol (nasic® 
Nasenspray) antiallergic nasal spray; Beclomethasone dipropionate (ratioAllerg® 
Heuschnupfenspray)] substances.

CAUTION

The presence of PCR inhibitors may cause false negative or invalid 
results.

12.1.2.3  Inclusivity
Inclusivity of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 was evaluated for different 
isolates of SARS-CoV-2 by wet testing or in silico analysis. The results are shown 
in Table 12 and 13.

Table   12: Inclusivity (wet testing) SARS-CoV-2 RT-PCR Kit 1.5

SARS-CoV-2 
Strain/Isolate 

Source/Sample Type Concentration

BetaCoV/Munich/ 
ChVir984/2020* 

Institute of Virology; 
Charité Berlin; Germany/ 

Heat inactivated cell culture 
supernatant

1.00E+04 copies/µl

2019-nCoV/Italy-INMI1
European Virus Archive 

Global/RNA
1.00E+06 copies/µl

* The strain BetaCoV/Munich/ChVir984/2020 was used for the determination of the LoD of the 
AltoStar® SARS-CoV-2 RT-PCR Kit 1.5
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Table   13: Inclusivity (In silico analysis for 258,701 whole genome sequences of SARS-
CoV-2 published via GISAID e.V. (www.gisaid.org) and 45,259 whole genome sequences 
published via National Center for Biotechnology Information (www.ncbi.nlm.nih.gov) as of 
January 11, 2021 for the E gene and the S gene target): AltoStar® SARS-CoV-2 RT-PCR 
Kit 1.5 (Catalogue number: AS0821517)

303,960 whole 
genome sequences

Homology Comment

E 
ge

ne

Forward Primer
303,629 sequences: 

100 %
328 sequences: 96.2 % (1 mismatch) 
3 sequences: 92.3 % (2 mismatches)

Reverse Primer
303,717 sequences: 

100 %
242 sequences: 95.5 % (1 mismatch) 
1 sequence: 90.9 % (2 mismatches)

Probe
303,707 sequences: 

100 %
252 sequences: 95.7 % (1 mismatch) 
1 sequence: 91.3 % (2 mismatches)

S 
ge

ne

Forward Primer
302,614 sequences: 

100 %
1,338 sequences: 95.2 % (1 mismatch) 
8 sequences: 90.5 % (2 mismatches)

Reverse Primer
300,399 sequences: 

100 %
3,553 sequences: 95.5 % (1 mismatch) 
8 sequences: 90.1 % (2 mismatches)

Probe
301,612 sequences: 

100 %

2,340 sequences: 96.3 % (1 mismatch) 
7 sequences: 92.6 % (2 mismatches) 
1 sequence: 85.2 %* (4 mismatches)

* The sequence (accession ID EPI_ISL_415593, GISAID) showed 4 mismatches in the 
S gene probe binding site. This sequence was published on March 10, 2020 originating 
from Washington, USA. Since then none of the published sequences showed that many 
mismatches again. The sequence was commented by the authors “Caution. Stretches of 
NNNs (1.74 % of overall sequence)”, indicating not ideal sequencing quality, the impact on 
the S gene specific oligonucleotides has therefore not been investigated.

Depending on the position, mutation events leading to ≤ 2 mismatch/es in a single 
oligonucleotide sequence are very unlikely to have any significant negative effect 
on the performance of the assay. All such sequences (≤ 2 mismatch/es) tested 
in wet lab experiments in the cause of the post market surveillance activities for 
the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 so far confirmed that the performance 
was not affected by such mutations. With the exception of one unique sequence 
none of the other analyzed sequences showed mismatches in more than one 
oligonucleotide and none of the mismatching sequences showed mismatches 
with both specific detection systems (E gene and S gene), hence reactivity of the 
specific oligonucleotides included in the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is 
not expected to be affected.
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 12.1.2.4  Cross Reactivity
The analytical specificity of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 with respect 
to cross reactivity with other pathogens than SARS-CoV-2 was evaluated by testing 
viruses related to SARS-CoV-2, viruses causing similar symptoms as an infection 
with SARS-CoV-2 and viruses likely to be present in patients suffering from a SARS-
CoV-2 infection. 

With the exception of SARS-coronavirus* the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 
did not cross react with any of the following pathogens:

• Human coronavirus 229E

• Human coronavirus OC43

• Human coronavirus NL63

• MERS-coronavirus

• Adenovirus

• Human Metapneumovirus (hMPV)

• Parainfluenza virus 1-4

• Influenza A virus

• Influenza B virus

• Enterovirus

• Respiratory syncytial virus A

• Respiratory syncytial virus B

• Rhinovirus

• Chlamydia pneumoniae

• Haemophilus influenzae

• Legionella pneumophila

• Mycobacterium tuberculosis

• Streptococcus pneumoniae

• Streptococcus pyogenes

• Bordetella pertussis

• Mycoplasma pneumoniae

• Pneumocystis jirovecii

• Candida albicans

• Pseudomonas aeruginosa

• Staphylococcus epidermidis

• Streptococcus salivarius

* A positive result is obtained for SARS-coronavirus with the AltoStar® SARS-CoV-2 RT-PCR 
Kit 1.5 in the FAM™ channel, since the E gene target is not SARS-CoV-2 specific, but 
detects all lineage B-betacoronaviruses including SARS-coronavirus.

CAUTION

In case the sample contains other pathogens than SARS-CoV-2 
competition with the target amplification or cross-reactivities may occur.
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12.1.3  Precision
Precision of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 was evaluated using a 
panel consisting of a SARS-CoV-2 high positive [50 x LoD (1.25 PFU/ml)], a SARS-
CoV-2 low positive [3 x LoD (0.75 PFU/ml)] and a SARS-CoV-2 negative swab 
sample. 5 runs were performed with different combinations of 3 AltoStar® SARS-
CoV-2 RT-PCR Kit 1.5 lots, 3 AltoStar® Purification Kit 1.5 lots and 3 AltoStar® 
Internal Control 1.5 lots. Runs were performed on 5 different days using 3 different 
AltoStar® Automation System AM16 and 3 CFX96™ DW Dx. Each panel member 
was tested in at least 4 replicates per run.

Repeatability (intra-run variability), inter-lot variability and reproducibility (total 
variability) were determined based on threshold cycle (Cq) values for the SARS-
CoV-2 high positive samples (see Table 14), as well as for the Internal Control in the 
SARS-CoV-2 negative samples (see Table 15).

Table   14: Precision data (CV % [Cq values]) for SARS-CoV-2 high positive samples 

SARS-CoV-2 High Positive 
Sample [Cq in the FAM™ 
Channel, target E gene]

SARS-CoV-2 High Positive 
Sample [Cq in the Cy5 

Channel, target S gene]

Intra-Run Variability 0.15 - 0.61 0.02 - 0.34

Inter-Lot Variability 0.44 0.41

Total Variability 1.83 1.22

All samples tested at 3 x LoD (low positive samples) were detected positive for 
SARS-CoV-2 (E gene and S gene).

 Table   15: Precision data (CV % [Cq values]) for the Internal Control in SARS-CoV-2 
negative samples

Internal Control

Intra-Run Variability 0.12 - 0.49

Inter-Lot Variability 0.39

Total Variability 1.02
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12.1.4  Total Failure Rate
The robustness of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 was assessed by 
testing 35 SARS-CoV-2 negative human swab samples from individual donors 
spiked with SARS-CoV-2 to a final concentration of the 3 x LoD (0.75 PFU/ml) 
in UTM® of negative upper respiratory swabs. All (35 out of 35) samples tested 
were tested positive in the SARS-CoV-2 specific fluorescence detection channels 
(FAM™ and Cy5, respectively).

12.1.5  Carry Over
Carry over is mostly a workflow dependent risk and independent of the PCR assay 
used. For the AltoStar® workflow the AltoStar® Parvovirus B19 PCR Kit 1.5 was 
used as exemplary model. Potential cross contamination through carry over from 
high positive samples was evaluated by testing alternating parvovirus B19 high 
positive (1.00E+07 IU/ml) and negative samples (n = 44 each per run; 2 runs) with 
the AltoStar® Parvovirus B19 PCR Kit 1.5. No carry over was observed (i.e. all 
parvovirus B19 negative samples were tested negative).

12.1.6  Diagnostic Evaluation
The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 was evaluated in a comparative 
study with the CE-marked Bosphore Novel Coronavirus (2019-nCoV) Detection 
Kit (Anatolia Geneworks). Retrospectively, 110 respiratory swab samples from 
routine SARS-CoV-2 monitoring were tested in parallel using the Bosphore 
Novel Coronavirus (2019-nCoV) Detection Kit in combination with the mSample 
Preparation Systems RNA (Abbott) and the m2000sp Instrument (Abbott) and the 
AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 in combination with the AltoStar® Purification 
Kit 1.5 and the AltoStar® Internal Control 1.5 on the AltoStar® Automation System 
AM16 and the CFX96™ DW Dx. For the qualitative analysis all samples with an 
invalid result for one or both assays were excluded. Results for the remaining 104 
samples are shown in Table 16.



115

AltoStar® SARS-CoV-2 RT-PCR Kit 1.5

Table   16: Results of the evaluation of the diagnostic sensitivity and specificty for SARS-
CoV-2 in respiratory swab samples 

Bosphore Novel Coronavirus (2019-nCoV) Detection Kit 
(Anatolia Geneworks)
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The diagnostic sensitivity and specificity of the AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 
compared to the Bosphore Novel Coronavirus (2019-nCoV) Detection Kit were 
100 % and 96 %, respectively.

13.  Quality Control
In accordance with the altona Diagnostics GmbH ISO EN 13485-certified Quality 
Management System, each lot of AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is tested 
against predetermined specifications to ensure consistent product quality.

14.  Technical Assistance
For customer support, please contact the altona Diagnostics Technical Support:

e-mail:  support@altona-diagnostics.com

phone:  +49-(0)40-5480676-0
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 16.  Trademarks and Disclaimers
AltoStar® (altona Diagnostics); BD MAX™ (BD); CFX96™, CFX Manager™, 
Hard-Shell® (Bio-Rad); Universal Transport Medium™, UTM® (Copan); nasic® 
(Klosterfrau Healthcare Group); ratioAllerg® (ratiopharm); FAM™, VIC™ (Thermo 
Fisher Scientific).

Registered names, trademarks, etc. used in this document, even if not specifically 
marked as such, are not to be considered unprotected by law.

The AltoStar® SARS-CoV-2 RT-PCR Kit 1.5 is a CE-marked diagnostic kit according 
to the European in vitro diagnostic directive 98/79/EC. 

Product is not licensed with Health Canada and not FDA cleared or approved. 

Not available in all countries. 

© 2021 altona Diagnostics GmbH; all rights reserved.
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17.  Explanation of Symbols
Symbol Explanation

V
In vitro diagnostic medical device

*
Global Trade Item Number

g
Batch code

.
Content

/
Cap color

h
Catalogue number

#
Number

,
Component

i
Consult instructions for use

X

Contains sufficient for "n" tests/reactions 
(rxns)

l
Temperature limit

H
Use-by date

M
Manufacturer

Y
Caution

&
Material number

A
Version

Note
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